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Abstrak — Kecemasan merupakan gangguan mental yang
sering dialami mahasiswa dan dapat mengganggu
keseimbangan psikologis, akademik, serta sosial. Penelitian ini
mengembangkan aplikasi Neurobliss, perangkat lunak desktop
yang memfasilitasi stimulasi gelombang otak alfa melalui musik
relaksasi dan binaural beats. Stimulasi audio ini bertujuan
meningkatkan aktivitas gelombang alfa (8-13 Hz) yang
berkaitan dengan relaksasi sekaligus menurunkan gelombang
beta yang terkait stres dan kecemasan. Proses stimulasi dan
monitoring menggunakan perangkat Muse EEG (Muse 2 dan
Muse S) yang merekam sinyal listrik otak secara non-invasif.
Data EEG diekspor dalam format CSV dan diproses dengan
MATLAB, meliputi filtering dengan Band Pass Filter (0,5-60
Hz), konversi ke European Data Format, dekomposisi sinyal
dengan Independent Component Analysis untuk
menghilangkan artefak, serta analisis spektral menggunakan
Fast Fourier Transform untuk memetakan distribusi daya pada
pita frekuensi otak. Diharapkan stimulasi audio ini dapat
meningkatkan daya gelombang alfa secara signifikan dan
menurunkan Kkecemasan. Dengan demikian, Neurobliss
menawarkan solusi teknologi untuk monitoring dan analisis
EEG sekaligus menjadi alternatif intervensi dalam pengelolaan
kesehatan mental mahasiswa.

Kata kunci— Binarual Beats, EEG, enchaned alpha,
kecemasan, Neurobliss

L PENDAHULUAN

A. Latar Belakang

Kecemasan adalah respons terhadap ancaman yang tidak
pasti dan dapat memengaruhi kondisi subjektif, perilaku,
serta fisiologi seseorang. Gangguan kecemasan ditandai
dengan ketakutan berlebihan tanpa alasan jelas dan berbeda
dari kecemasan biasa. Gejalanya meliputi kegelisahan,
kelelahan, kesulitan konsentrasi, mudah tersinggung, dan
gangguan tidur.

Gangguan ini cukup umum, khususnya pada remaja dan
mahasiswa. Data WHO menunjukkan 11,7-14,7%
mahasiswa di 21 negara mengalami gangguan kecemasan. Di
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Indonesia, survei I-NAMHS menunjukkan lebih dari
sepertiga remaja mengalaminya, dan di Universitas Telkom,
sekitar 9—11% mahasiswa terdampak, dengan kecemasan
sebagai masalah utama yang mempengaruhi prestasi
akademik dan interaksi sosial.

Kondisi emosional dapat dipantau melalui sinyal EEG,
yang membagi aktivitas otak ke dalam lima rentang
frekuensi: delta, teta, alfa, beta, dan gamma. Gelombang beta
berhubungan dengan kecemasan, sedangkan gelombang alfa
dengan relaksasi. Binaural beats (BB), khususnya pada
frekuensi alfa, terbukti efektif meningkatkan kesehatan
emosional hingga 87% dalam tiga hari menurut studi Sharma
& Choudhary. Penggabungan BB dan analisis EEG dapat
menjadi pendekatan potensial untuk memahami dan
mengelola kecemasan, meskipun tetap memerlukan validasi
profesional.

B.  Analisis Masalah
Analisis masalah dibagi menjadi beberapa aspek, yaitu
aspek psikologi, aspek sosial, aspek budaya dan askpek
teknis.
a. Aspek Psikologi
Anxiety dapat mengganggu emosi seperti gelisah,
sulit tidur, dan hilang nafsu makan. Trauma masa kecil
dapat memicu gangguan emosi (Nicoara N), dan kondisi
mental buruk memengaruhi sistem saraf otonom (Lee J
dkk). Pada penderita kecemasan, amigdala menjadi

overaktif dan medial prefrontal cortex gagal
mengontrolnya, menyebabkan respon emosional
berlebihan.

b.  Aspek Sosial

Remaja usia 10-24 tahun rentan terhadap gangguan
mental, terutama di negara berpenghasilan rendah karena
akses layanan kesehatan terbatas. Status ekonomi
rendah, tekanan akademik, dan media sosial negatif
memperburuk kondisi psikologis. Penelitian
menunjukkan bahwa kecemasan berdampak pada
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prestasi, hubungan sosial, dan bisa memicu keinginan
bunuh diri.

c. Aspek Budaya

Budaya merupakan salah satu faktor yang
memengaruhi gangguan kecemasan, meskipun secara
tidak langsung. Menurut Zentner dkk, pengaruh budaya
tercermin dari cara individu memandang dan
menjelaskan diri mereka. Contohnya, orang Asia-
Kanada yang lebih interdependen cenderung lebih rentan
terhadap kecemasan sosial. Budaya juga membentuk
konsep diri dan peran gender, yang dapat meningkatkan
kerentanan terhadap kecemasan sosial. Di Indonesia,
menurut N. Praharso, kesadaran masyarakat terhadap
kesehatan mental masih rendah. Masalah mental sering
dianggap tidak penting, dan penderitanya cenderung
dijauhi atau distigmatisasi.

d. Aspek Teknis

Diagnosis gangguan kesehatan mental hanya dapat
dilakukan oleh psikolog, psikiater, atau ahli terkait,
dengan acuan dari buku DSM-5 yang diterbitkan oleh
American Psychiatric Association pada tahun 2013.
Namun, teknologi seperti MATLAB dapat digunakan
untuk membantu analisis sinyal, dan machine learning
juga mulai dikembangkan untuk mengenali kecemasan
melalui data EEG atau biomarker lainnya. Inovasi ini
membuka peluang untuk menciptakan perangkat bantu
diagnostik guna mendukung kerja para profesional
kesehatan mental.

C. Tujuan

Berdasarkan analisis masalah diatas, tujuan dari tugas
akhir ini adalah melakukan observasi mengenai pengaruh
stimulasi sinyal alfa untuk menurunkan tingkat kecemasan
dari perubahan frekuensi sinyal otak alfa dan beta melalui
analisis sinyal EEG dan memanfaatkan teknologi untuk
memberikan  pendekatan ilmiah dalam pengelolaan
kecemasan melalui suatu aplikasi praktis dengan stimulasi.

IL. KAJIAN TEORI

a. Anxiety Disorder
Gangguan kecemasan merupakan salah satu bentuk

masalah kesehatan mental yang cukup sering dialami oleh
mahasiswa. Kondisi kecemasan yang berlebihan dapat
mengganggu keseimbangan dalam menjalani aktivitas
harian. Mahasiswa dan remaja termasuk kelompok yang
sangat rentan terhadap gangguan ini, karena tuntutan situasi
yang mengharuskan mereka lebih mandiri dalam menghadapi
berbagai persoalan [13].

b. Elektroensefalogram (EEG)

Elektroensefalogram (EEG) pada dasarnya digunakan
untuk merekam aktivitas osilasi listrik dari neuron yang
berada di korteks serebral. Sinyal EEG memuat gelombang
dengan berbagai rentang frekuensi [13]. Aktivitas tersebut
biasanya dikelompokkan menjadi beberapa pita, yaitu delta
(kurang dari 4 Hertz), teta (antara 4 hingga 8 Hertz), alfa (8
sampai 13 Hertz), beta (13 sampai 30 Hertz), dan gamma (30
hingga 100 Hertz) [4].

c. Stimulus Enhanced Alpha

e-Proceeding of Engineering : Vol.12, No.4 Agustus 2025 | Page 4982

Stimulasi enhanced alfa adalah metode untuk
meningkatkan aktivitas gelombang otak alfa (8—13 Hz),
biasanya melalui audio, visual, atau arus listrik rendah [21],
[22]. Otak merespons osilasi dari stimulasi yang diterima.
Teknik ini digunakan dalam terapi nyeri (9 Hz), pengurangan
stres dan kecemasan (10-30 Hz), serta peningkatan memori,
kognisi, dan pemulihan cedera otak (10,2 Hz) [23].

d. Independent Component Analysis (ICA)

Pada dasarnya ICA adalah sebuah teknik untuk
memisahkan sekumpulan sinyal tercampur menjadi sinyal-
sinyal yang independen pada sumber aslinya. Berikut adalah
rumus dasar model ICA:

x =As

Dimana x adalah vektor dari sinyal yang diamati (observed
mixtures), A adalah matriks pencampur yang elemen-
elemennya tidak diketahui (mixing matrix), dan s adalah
vektor dari komponen-komponen independen (source
signals).

e. Band Pass Filter (BPF)

Band Pass Filter (BPF) merupakan alat atau rangkaian
yang memungkinkan sinyal dalam rentang frekuensi tertentu
(passband) untuk lewat, sambil menekan frekuensi di luar
rentang tersebut [25]. BPF banyak digunakan dalam sistem
komunikasi, radar, dan perangkat elektronik lain untuk
menyaring sinyal yang diinginkan dan mengurangi gangguan
dari frekuensi lain. Band Pass Filter (BPF) dalam pengolahan
sinyal EEG berfungsi untuk menyaring dan membatasi
rentang frekuensi sinyal yang dianalisis, sehingga hanya
frekuensi yang relevan dengan aktivitas otak yang diambil
[26].

[ Fast Fourier Transform (FFT)

Fast Fourier Transform (FFT) adalah algoritma efisien
hasil pengembangan dari Discrete Fourier Transform (DFT),
yang digunakan untuk mengonversi sinyal dari domain waktu
ke domain frekuensi dengan presisi tinggi [28]. Algoritma
FFT dapat memproses transformasi lebih cepat daripada DFT
karena ada pengurangan di proses looping [28]. Transformasi
fourier secara matematis dinyatakan dalam persamaan.

s(f) = JOO s(t)e /2t dt
(1)

I11. METODE
A. Desain Sistem

Stimulasi alfa yang digunakan berupa stimulasi audio,
yaitu musik relaksasi yang dikombinasikan dengan binaural
beats (BB). Musik relaksasi meliputi suara alam, musik
klasik, dan musik populer, sementara BB bekerja dengan
menciptakan ilusi frekuensi di otak melalui perbedaan suara
di telinga kiri dan kanan, menggunakan rentang 8-13 Hz,
umumnya 10 Hz (contohnya dari 240 Hz dan 250 Hz).

Penelitian stimulus alfa ini dilakukan secara terorganisir
melalui kolaborasi antara Universitas Telkom dan UNISBA,
dengan tujuan utama mengumpulkan data untuk dianalisis
dalam aplikasi Neurobliss. Aplikasi ini dirancang untuk
membantu psikolog mendiagnosis kondisi mental pasien
berdasarkan rekaman EEG setelah pemberian stimulus.
Neurobliss memiliki fitur untuk menyimpan data pasien,
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menampilkan berbagai jenis stimulus alfa, serta menganalisis
rekaman EEG secara mendalam.

l Mulai }—’< Pra perek "{ Prloses H P?sca

GAMBAR 1
(Alur Implementasi Sistem)

L, Pengolahan data S \
sinyal EEG <
| —

H/\

Implementasi tersebut merujuk kepada proyek capstone
design yang diawali dengan proses pemilihan reponden oleh
tim psikolog dari kemahasiswaan Universitas Telkom
Bandung. Responden terpilih akan dijadwalkan untuk
memasuki sesi eksperimen yang telah ditetapkan oleh tim
peneliti.

1. Pra Perekaman

Dalam persiapan pelaksanaan eksperimen, responden
yang telah terpilih akan memasuki ruang tunggu, alur tersebut
disebut tahap pra pereckaman. Tahap ini bertujuan untuk
mengevaluasi awal kondisi psikologis responden oleh tim
psikolog dari UNISBA. Selanjutnya, tim peneliti akan
menjelaskan secara singkat mengenai pengujian stimulus
yang akan dilakukan.

2. Proses perekaman

Pada tahap perekaman EEG, responden ditempatkan di
ruangan khusus eksperimen dan menggunakan berbagai
perangkat seperti Muse S/Muse 2, gel EEG, webcam, laptop,
tablet, dan earphone. Muse 2/S berfungsi merekam aktivitas
otak, sedangkan gel EEG menjadi konduktor antara alat dan
kulit kepala. Tablet dan aplikasi Mind Monitor digunakan
untuk mencatat sinyal otak, sementara laptop dan OBS
digunakan untuk memutar dan merekam stimulus serta video
responden. Stimulus audio BB dikirim melalui earphone dan
dikendalikan lewat aplikasi Neurobliss.

Dalam eksperimen ini, responden yang mengalami
peningkatan stres diberikan stimulus alfa berupa binaural
beats (10 Hz) yang dikombinasikan dengan musik relaksasi,
bertujuan untuk meningkatkan gelombang alfa otak yang
terbukti efektif dalam meredakan kecemasan dan
menciptakan relaksasi. Proyek ini merupakan bagian dari
capstone dan menggunakan software seperti Mind Monitor,
Neurobliss, dan OBS untuk mendukung proses perekaman
dan analisis data.

3. Pasca Perekaman

Setelah proses perekaman EEG selesai, responden
dipindahkan kembali ke ruangan awal untuk menjalani
evaluasi psikologis oleh tim psikolog dari UNISBA. Evaluasi
dilakukan melalui pengisian form berisi pertanyaan
psikologis serta wawancara langsung guna menilai kondisi
responden setelah menerima stimulus alfa.

Sebagai bentuk apresiasi, responden diberikan reward
berupa makanan dan minuman atau saldo e-wallet. Seluruh
data hasil perekaman, baik dari alat EEG maupun video OBS,
disimpan dan diunggah ke link Google Drive yang telah
disediakan untuk keperluan dokumentasi dan analisis lebih
lanjut.

4. Pengolahan Data

Data dari aplikasi Mind Monitor disimpan dalam format
.csv, kemudian diproses melalui tahapan pre-processing
seperti  ICA, pemfilteran sinyal, dan segmentasi
menggunakan FFT. Tujuan utamanya adalah
mentransformasikan sinyal ke domain frekuensi agar daya
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pada setiap frekuensi dapat dianalisis selama sesi stimulasi
EEG.

B.  Implementasi
1. Responden

Partisipan dengan kondisi mental normal dipilih oleh
psikolog Universitas Telkom berdasarkan kriteria tertentu
untuk menjaga validitas penelitian. Sebelum eksperimen,
partisipan diminta membaca dan menandatangani inform
consent yang disusun bersama psikolog UNISBA, berisi

kriteria serta prosedur pelaksanaan stimulasi.
‘ |

GAMBAR 2
(Pengisian Inform Consent Oleh Responden)

2. Eskperimen

Penelitian ini bertujuan menguji efektivitas stimulasi
audio dalam meningkatkan gelombang otak alfa, yang
berkaitan dengan kondisi relaksasi. Stimulus bekerja dengan
cara mengosilasi frekuensi otak agar meningkatkan aktivitas
alfa, yang diamati melalui perubahan dari gelombang beta ke
alfa. Eksperimen ini membandingkan aktivitas otak sebelum
dan sesudah pemberian stimulus, serta menganalisis
perubahan daya frekuensi, terutama pada frekuensi alfa dan
high beta.

EEG Muse

————-———-—-————-50 Y e e

Earphone

monitor

responden

GAMBAR 3
(Ilustrasi Pelaksanaan Perekaman Data Responden)

3. Perekaman Stimulasi

Partisipan awalnya diberi stimulus beta untuk
meningkatkan stres, lalu mendengarkan stimulus alfa guna
menginduksi relaksasi. Selama proses, EEG dan OBS
merekam respons otak dan ekspresi wajah, dibantu oleh
hardware, software, dan dua operator.
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GAMBAR 4
(Pengambilan Data EEG dan Rekaman EEG)

C. Hardware

Untuk melakukan proses perekaman stimulus alfa
diperlukan alat atau device pendukung seperti Muse
(elektroda), laptop, tablet, webcam, earphone, dan gel eeg.
1. Wearable EEG Muse

Perangkat wearable Muse 2 dan Muse S Band seperti
pada Gambar 4.5 merupakan alat yang diproduksi oleh
Interaxon Inc., sebuah perusahaan neuroteknologi dari
Toronto, Kanada. Alat tersebut berfungsi untuk merekam
aktivitas sinyal listrik pada otak manusia. Muse EEG wireless
yang memiliki 4 channel yaitu TP9, AF7, AFS8, dan TP10

GAMBAR 5
(Perangkat Muse S dan Muse 2)

2. Laptop

Laptop merupakan perangkat yang digunakan untuk
menjalankan software Neurobliss yang berisi stimulus alfa
yang akan diputar oleh responden. Rekaman webcam
dilakukan melalui aplikasi OBS pada laptop.

GAMBAR 6
(Laptop)

3. Tablet atau HP Android

Tablet digunakan sebagai media perangkat untuk
menghubungkan perangkat elektroda Muse 2 dengan
software Mind Monitor berfungsi untuk merekam data sinyal
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EEG. Tablet yang digunakan harus dengan system operasi
android.

GAMBAR 7
(Tablet)

4.  Webcam

Webcam digunakan sebagai perangkat pendukung untuk
software OBS dalam merekam aktivitas responden. Webcam
yang digunakan saat stimulasi berjumlah 2 buah, yang
digunakan untuk merekam reaksi ekspresi dari depan dan
respon jawaban dari samping.

GAMBAR 8
(Webcam)

5. Earphone

Earphone sebagai perangkat untuk memaksimalkan
pengalaman responden pada sesi stimulus alfa dengan
mendengarkan suara/musik dari aplikasi Neurobliss caranya
dengan menyalurkan perbedaan bit di masing-masing telinga
dengan baik, dan meredam suara gangguan dari luar selain
stimulasi agar responden lebih fokus.

GAMBAR 9
(Earphone)

6. Gel EEG

Gel EEG berfungsi sebagai konduktor antara kulit kepala
dengan perangkat Muse. Gel digunakan apabila elektroda
tidak dapat mendeteksi sinyal otak. Gel yang digunakan
merupakan gel konduktif.
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GAMBAR 10
(Gel EEG)

D. Software

Proses perekaman stimulus menggunakan software untuk
tujuan masing-masing. Untuk aplikasi Mind Monitor
digunakan sebagai platform media untuk merekam sinyal
EEG, kemudian aplikasi Neurobliss digunakan sebagai
platform media stimulus alfa. OBS digunakan untuk
merekam aktivitas yang dilakukan selama pengambilan data.
Aplikasi-aplikasi yang disebutkan ini digunakan selama
perekaman stimulus berlangsung.

1. Neurobliss

a) Aplikasi Neurobliss sebagai platform stimulasi

Untuk memudahkan implementasi metode ini, kami
mengembangkan  sebuah  aplikasi  bernama
Neurobliss, yang berfungsi sebagai platform utama
bagi partisipan dalam menerima stimulus alfa.
Aplikasi ini menyediakan dua jenis audio berbeda
yang sama-sama mengandung frekuensi alfa, namun
dengan variasi musik relaksasi dan binaural beats.
Setiap audio telah dimodifikasi secara khusus untuk
memastikan  efektivitas  stimulasi.  Neurobliss
dirancang untuk memberikan pengalaman yang
nyaman dan mudah diakses oleh pengguna. Aplikasi
Neurobliss dikembangkan menggunakan Flutter
sebagai framework dan Dart sebagai bahasa
pemrograman untuk memastikan kompatibilitas dan
performa yang optimal. Aplikasi ini ditujukan untuk
platform desktop (PC/Laptop) dengan sistem
operasi Windows, sehingga dapat diinstal di
perangkat spek yang minim. Neurobliss bersifat
lokal artinya tidak memerlukan koneksi internet
setelah diinstal, sehingga menjaga privasi dan
kenyamanan pengguna.

b) Fungsi dan desain aplikasi Neurobliss

e Halaman Depan: Dibuat dengan antarmuka
yang sederhana dan intuitif, menampilkan
kolom informasi pengguna yang dibutuhkan
untuk login, serta tombol navigasi ke menu
utama. Halaman ini juga memiliki fitur untuk
mengubah password jika user lupa password
sebelumnya. User akan diberikan beberapa
pernyataan sebelum dapat mengganti
password.
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InputField Username

InputField Password
Ubah Password

Tombol Login

GAMBAR 11
(Halaman Depan)

e Halaman Utama: Kodingan halaman ini
memiliki fungsi utama sebagai antarmuka awal
yang menampilkan 4 tombol navigasi utama.
Setiap tombol menggunakan desain visual yang
sederhana namun konsisten.

Tombol Daftar Responden

*
' (
. Tombol Registrasi Responden
Tombol Menu Sesi Audio
Tombol Menu Analisis

GAMBAR 12
(Halaman utama)

e Halaman Registrasi: Pada halaman ini,
pengguna dapat mengisi data diri berupa nama
lengkap, umur, serta instansi

* =)
InputField untuk mengisi data
——— diri responden (nama lengkap,

umur, instansi)
Tombol untuk meng-submit
data diri responden

B

o

GAMBAR 13

(Halaman register)

e Halaman Daftar Responden: Halaman ini
berfungsi untuk menampilkan daftar responden
yang telah terdaftar. Pengguna juga dapat
mengedit dan menghapus data mereka yang
telah tersimpan menggunakan
SharedPreferences. Berikut adalah bagian
kodingan dari halaman daftar responden.

Tombol Hapus Data Responden
Tombol Edit Data Responden
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GAMBAR 14
(Halaman daftar responden)

e Halaman Sesi: Pengguna dapat memilih audio
berupa binaural beats maupun musik sebelum
memulai sesi di halaman ini. Hal ini bertujuan
untuk memberikan pengalaman personalisasi
audio kepada pengguna sebelum memulai sesi
enhanced alpha.

Daftar Audio Binaural Beats

ST

Daftar Audio Musik + Binaural
Beats

GAMBAR 15
(Halaman Sesi)

e Halaman Pemutar Audio: Halaman ini
berfungsi untuk menampilkan sesi pemutaran
audio yang dipilih pengguna di halaman
sebelumnya, disertai dengan timer hitung
mundur.

Tampilan Ketika Audio
Dimainkan

GAMBAR 16
(Halaman pemutar audio)

e Halaman Analisis: Pengguna bisa mengelola
dan menganalisa hasil data dari sesi yang telah
dilakukan, secara online maupun offline.

*

Tombol untuk menganalisis
hasil rekaman EEG secara
online

Tombol untuk menganalisis

hasil rekaman EEG secara
offline

GAMBAR 17
(Halaman analisis)
e  Mindmonitor.com merupakan tampilan untuk
analisis menggunakan web yang disediakan
dari aplikasi mind monitor.
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Online Charts frpm csv

Selet

GAMBAR 18
(mind-monitor.com/Chart.php)

e  Csvgraphs.exe merupakan tampilan untuk
analisis data mentah yang menampilkan
visualisasi magnitude sinyal delta, teta, alfa,
beta, dan gama.

# EES 2ana Mlottey - o *

Salret 5V File

Mo fleseiectes | GelectFile

Selnct BEG Bands bo Flot

Ellets & Thte [ Aiphe [ Fetn 2 famma

Select Time Fange

Shart Times
tra lme 1

Update Plsy

EEGEands (P9 SEZ B, OFT EEGEands - AFE EEG Zands D TawFEG PO Raw EEG - AF7 Fa SEG - AFD faw RGP0 Arcelaamidis

GAMBAR 19
(csvgraphs.exe)

2. OBS Studio

OBS Studio merupakan aplikasi untuk merekam
aktivitas responden pada saat sesi perekaman data
berlangsung. Untuk mendukung maksimal proyek capstone
ini digunakan dua webcam dengan penempatan yang sesuai.
Webcam satu merekam secara langsung pada wajah
responden untuk melihat ekspresi ataupun respon dari emosi
dan gerakan responden. Webcam dua merekam posisi tangan,
keyboard dan layer monitor untuk melihat respon. Lalu kedua
webcam tersebut digabungkan ke dalam satu screen dan
ditambahkan script timestamp pada aplikasi OBS Studio.

00:00:00,00

GAMBAR 20
(OBS Studio)

3. Mind Monitor
Mind Monitor merupakan aplikasi pihak ketiga yang
dibuat secara khusus untuk perangkat Muse. Aplikasi ini
berfungsi untuk membaca, menampilkan, dan merekam
data gelombang otak EEG dari Muse secara langsung.
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24Hz  32Hz  40Hz  48Hz  56Hz

*r8000O@0# s

GAMBAR 21

E.  Tujuan Pengembangan Aplikasi Neurobliss

Tujuan utama dari aplikasi Neurobliss adalah menjadi
platform terapi audio bagi individu yang mengalami stres
atau tekanan psikologis. Dengan menyediakan stimulus alfa
dalam bentuk audio yang mudah diakses, aplikasi ini
diharapkan dapat membantu pengguna mencapai kondisi
relaksasi lebih cepat dan efektif.

F.  Stimulus Alfa Berbasis Audio

Stimulasi alfa dilakukan dengan kombinasi musik
relaksasi dan Binaural Beats (BB) yang menciptakan ilusi
frekuensi 10 Hz dalam rentang gelombang alfa. Musik
bertempo lambat dan suara alam ditambahkan untuk
meningkatkan kenyamanan. Audio dibuat dengan Audacity
3.6, menggunakan frekuensi 240 Hz dan 250 Hz pada telinga
kanan dan kiri. Kombinasi ini efektif meningkatkan aktivitas
gelombang alfa dan mencegah kebosanan, dengan durasi
sekitar 5 menit.

@ ey

GAMBAR 22
(Kombinasi Audio di Aplikasi Audacity)

G. Kuesioner

Saat pengambilan data, responden diberikan dua
kuesioner untuk mengetahui kondisi psikologis mereka
sebelum dan sesudah diberikan stimulasi. Kuesioner kondisi
diri pra eksperimen diberikan sebelum responden masuk ke
sesi stimulasi. Setelah selesai stimulasi, responden juga
diberikan kuesioner untuk apa yang mereka rasakan setelah
stimulasi. Respon yang diberikan dari kedua kuesioner
tersebut dapat menjadi acuan non teknis, untuk mengetahui
keberhasilan stimulasi.

H. Pengolahan Data Sinyal EEG
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Konversi file EDF ke

Csv

Transformasi fourier
dengan FFT

Segmentasi sesuai
durasi stimulasi

Output :
File csv

GAMBAR 23
(Flowchart Pengolahan Data)

Filtering BPF

I

Konversi file CSV
ke EDF

b

Dekomposisi ICA

1. File CSV
Dalam proyek capstone ini, data EEG mentah diperoleh
dari eksperimen stimulus menggunakan aplikasi Mind
Monitor pada tablet, lalu diekspor ke PC dalam format .csv.
Data tersebut belum melalui proses pre-processing seperti
filtering atau ICA. Penelitian difokuskan pada empat channel
EEG, yaitu TP9 dan TP10 (area Temporo-Parietal) serta AF7
dan AF8 (area Anterior Frontal).
TimeStamp ~ RAW_TPS RAW_AF7 RAW_AF8 RAW_TP1C
03:30.3
03:30.3 819.1575 796.9963 §08.2784 387.6191
03:30.3 1650 839.707 823.5897 1526.3
03:30.3 1650 822.381 824.7985 1650
03:30.3 807.8755 778.8644 805.4579 1009.341
03:30.3 0 751.0623 785.7143 0
03:30.3 692.2344 803.8461 B804.652 240.5495
03:30.3 1643.956 854.2125 823.5897 1374.799
03:30.3 1650 846.5568 820.7692 1650
03:30.3 963.8095 790.5494 §03.4432 1071.392
03:30.3 0 726.4835 780.4762 0
03:30.3 663.6264 766.7766 794.9817 47.14286
03:30.3 1848.791 823.5897 815.9341 1122.967
03:30.4 1650 826.8132 813.5165 1650
03:30.4 1010.549 799.011 796.1805 1201.136
03:30.4 0 759.5233 776.8498 77.76556
03:30.4 633.0037 792.1612 793.7729 0
03:30.4 1844.359 850.1832 817.9487 949.707
03:30.4 1650 853.8095 816.7399 1650
03:30.4 1015788 820.3663 806.6667 1402.198
GAMBAR 24
(Data Mentah Rekaman EEG)

2. Flitering BPF (Band Pass Filter)

Setelah mendapatkan file csv dilakukan proses filter
BPF. BPF adalah jenis filter yang bertujuan untuk
memperoleh frekuensi di antara dua batas (lower cut-off
frequency dan upper-cut off frequency). Proses ini
merupakan proses awal yang penting karena gelombang otak
manusia memliki rentang frekuensi yang terbatas yaitu delta,
teta, alfa, beta, dan gama.

% Buat filter bandpass 0.5-60 H=
[k, al] = butter(4, [0.5 €0]/(Fs/2),

% Terapkan filter
filtered values = filtfiltib, a, raw values);

'bandpass ") ;

GAMBAR 25
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(Skrip Pemrograman MATLAB Filter BPF)

Dalam pengolahan sinyal EEG, digunakan filter
Butterworth orde 4 dengan Band Pass Filter (BPF) pada
rentang 0,5-60 Hz. Filter ini dipilih karena memiliki respon
frekuensi yang halus tanpa riak di passband, dan orde 4
dianggap ideal agar tidak menimbulkan distorsi sinyal, yang
umum terjadi pada orde yang lebih tinggi

GAMBAR 26
(Perbandingan Sinyal Sebelum (atas) dan Sesudah di Filter
dengan BPF)

3. Konversi ke EDF

Sebelum melakukan dekomposisi ICA, data csv perlu
dikonversi ke format EDF, hal ini perlu dilakukan agar file
tersebut bisa melewati tahap proses dekomposisi ICA di
aplikasi MATLAB. Konversi ke EDF dilakukan di website
google colab menggunakan bahasa python.

$ = Fungsi Konversi CSV ke ZDF —=
def convert_csv_vo_edf(file name csv, sawple frequency=25¢, selected _colums=lone
try:
df = pd.read esv(file name_csv)
if selected columms is not Nome:
missing_cols = [col for col in selected columns if col not in df.colum
if missing_cols:
raise ValueZrror{f'Holom tidak ditemkan di CSV: {missing cols}")
df = dffselected_columsl

df_mumeric = df.select_dtypes|include=[np.mmbex])
if df rumeric.empty:
raise ValueError ("Tidak ada kolom mumerik setelah filter.”)

signals = df mumeric.to mumpyl).T
signals = rp.nan_to_mum|signals)
n_channels = signals.shapel[0]

£ile name_edf = file name_csv.zeplace (".csv", ".ed")
if 0s.path.exists [file_name_edf) -
os_remove (File name_edf)
chamnel_info = [
for i in range(n_chamels):
signal = siguals[i]
col name = df mumeric.colums[i]
channel_info.sppendi{
"1bel’: col_name,
‘dimension': 'uWi’,
'sarple_frequency': sample frequency,
'physical min': float(np.min(signal)),
‘physical_ms loat{np.max{signal)),
‘digital_min &
‘digital max
‘transducez': '',
‘prefiltec’: '

h

edf writer = pyedflib.EdfWriter|file name edf, n channels=n channels)
edf_writer.setSignalHeaders (channel_info)

edf writer writeSamples(signals)

edf writer.close()

print (£"[] File EDF berhasil dibuat: {file_name edf}™)
return file name_edf
except Exception as e:

print (£" ¥ Error saat konversi CSV ke EDF: {strie)}")
return None

GAMBAR 27
(Kodingan Python EDF Converter)
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4.  Dekomposisi ICA

Tahap dekomposisi ICA (Independent Component
Analysis) sangat penting dalam pengolahan data EEG karena
berfungsi untuk menghilangkan noise dan artefak dari
aktivitas non-otak, seperti gerakan otot atau kedipan mata,
yang hanya muncul pada kanal tertentu. ICA mampu
mengidentifikasi dan membersihkan kanal yang mengandung
mayoritas gangguan. Proses ini dijalankan menggunakan
MATLAB dengan bantuan EEGLAB, sebuah toolbox khusus
untuk pemrosesan sinyal EEG. .

EEGLAB v2025.0.0

File Edit Tools Plot Study Datasets Help ¥

—No current dataset

Suggested steps to get started

- Create a new or load an existing dataset:
Use "File > Import data” {new)
Or "File > Load existing dataset™ (load)

{find tutorial data in sample data folder)
1

If newly imported raw dataset
"Edit > Channel locations" (look up locations) L
"File > Import event info" (for continuous data)
5 — Filter data: "Toecls > Filter data”

- Reject data: "Tools > Reject data by sye"

Run ICA: "Tools > Run ICA" (can take time)

Reject by ICA: "Tools > Reject data using ICA"

Epoch data: "Tools > Extract epochs"

— Plot ERP: "Plot > Channel ERP > In scalp array" i
g
= i
GAMBAR 28
(EEGLAB)

Proses analisis ICA bertujuan untuk menghilangkan
komponen noise tanpa merusak keseluruhan sinyal otak pada
kanal EEG. Meskipun komponen artefak dihapus, sinyal
tetap terdistribusi dengan baik. Contohnya, pada Gambar
4.37 ditunjukkan penghapusan komponen ke-4 yang
didominasi oleh line noise.
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View components properties -...

Brain : 88.2%

Brain : 77.0%

204

1w

204
.94

Brain : 71.4%

Brain : 97.5%

Brain : 88.6%

GAMBAR 29
(ICA Analisis Menghapus Komponen Line Noise)

5. Konversi ke CSV

Data hasil analisis ICA disimpan dalam format EDF dan
perlu dikonversi kembali ke .CSV untuk lanjut proses
transformasi fourier. Konversi data dilakukan melalui
kodingan python. Data hasil analisis ICA disimpan dengan
format waktu ms, dan elektroda TP9, AF7, AFS, TP10

edf_reader = pyedflib EdfReader|edf file)
n_channels = edf_reader.signals_in file
signal labels = edf reader.getSignallabels()

sample rate = edf reader.getSampleFrequency(l)
n_samples = edf_reader.getNSamples() (0]
4 RArbil data dari semua channel
data = np.zeros(in_samples, n channels))
for i in rangein_channels):

datal:, i] = edf reader.readSignalii)
edf_reader.close ()

# Buat timestarp

timestamps = np.arange(n sanples) / sample rate
4 Simpan ke DataFrame dan CSV

df = pd.DataFrame(dsta, colums=signal labels)
df insert(d, 'TimeStamp', timestamps)
df.to_cswlesv_output, indes=False)

GAMBAR 30
(Konversi EDF ke CSV)

6. Fast Fourier Transform

Dalam analisis EEG, sinyal dikategorikan menurut
rentang frekuensi gelombang otak seperti delta, theta, alpha,
beta, dan gamma. Karena sinyal awal berada di domain
waktu, diperlukan konversi ke domain frekuensi
menggunakan metode Fast Fourier Transform (FFT), yaitu
algoritma yang secara efisien mengubah sinyal agar
komponen frekuensinya dapat dianalisis.
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% —— Flot : FET dari Segmen ——
subploti€,1,1);

n = length(y_segment) ;
Y = ££t{y_segment);
B2 = abs (T/n) ;

title(sprintf ('FET dari Segmen (% 2f - % 2f detik)',t_segment_abs (1),
t_segment_zbs (end) )17
xlabel ("Freluensi (Hz)'); ylabel| Magnitudo');

x=1im([0 €31);

GAMBAR 31
(Skrip FFT pada Pemrograman MATLAB)

7. Segmentasi Awal dan Akhir

Setelah klasifikasi frekuensi dilakukan, sinyal EEG
disegmentasi berdasarkan waktu saat responden menerima
stimulus. Segmentasi ini membandingkan aktivitas otak saat
stimulus video/game dengan stimulus binaural beats (BB).
Sinyal kemudian divisualisasikan dalam rentang 0,5-60 Hz
dan dipisahkan sesuai dengan osilasi gelombang otak.

[ —— ey

G 130 48

GAMBAR 32
(Klasifikasi Frekuensi Sinyal ke Pita Frekuensi Delta, Teta,
Alfa, Beta, dan Gama)

IV. HASIL DAN PEMBAHASAN

A. Pengujian Aplikasi

Pengujian awal aplikasi dilakukan dalam sesi trial untuk
menilai kinerja sebelum digunakan lebih lanjut. Evaluasi
dilakukan oleh tim peneliti EEG dan UNISBA, dengan
penilaian meliputi kemudahan akses, performa, tampilan, dan
keamanan, menggunakan skala 1-5. Nilai rata-rata dihitung
dari seluruh skor responden, kemudian diklasifikasikan ke
dalam kategori penilaian berdasarkan rentang nilai yang telah
ditentukan. Berikut kategori skor 1-5 untuk penilaian aplikasi

a. Nilai 1 = Sangat Tidak Setuju

b. Nilai 2 = Tidak Setuju

c. Nilai 3 = Netral

d. Nilai 4 = Setuju

e. Nilai 5 = Sangat Setuju

TABEL 1
(Evaluasi Aplikasi Trial)

Paramater Nilai
Kemudahan Akses 4,58
Performa Aplikasi 4,50
Tampilan Aplikasi 5,00
Keamanan Aplikasi 4,83

Hasil evaluasi awal aplikasi menunjukkan respons sangat
positif dari tim peneliti EEG. Tampilan aplikasi mendapat
skor tertinggi yaitu 5.00, menunjukkan kepuasan penuh
terhadap desain antarmuka. Keamanan aplikasi mendapat
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skor 4.83, menandakan kepercayaan tinggi terhadap
perlindungan data. Kemudahan akses dan performa juga
dinilai baik dengan skor masing-masing 4.58 dan 4.50.
Pengujian lanjutan dilakukan setelah pengambilan data
EEG, menggunakan kuesioner Google Form yang mencakup
aspek desain, performa, dan keamanan. Penilaian dari 32
responden  menghasilkan  hasil yang memuaskan,
memperkuat kualitas aplikasi secara keseluruhan.

TABEL 2

(Penilian Aplikasi Hasil Kuesioner)
No | Pertanyaan Rata-
rata
skor
1 Seberapa mudah pengguna 4,56
memahami antarmuka
aplikasi?
2 Penggunaan font 4,50
memudahkan pembaca
dalam memahami isi tulisan
3 Seberapa mudah pengguna 4,43
menemukan fitur yang
dibutuhkan?
4 Bagaimana tingkat respons | 4,50
aplikasi  saat pengguna
menggunakannya?

Kategori

Setuju

Setuju

Setuju

Setuju

5 Apakah aplikasi terasa aman | 4,40
dalam hal perlindungan data
pribadi?

6 Seberapa puas anda dalam 4,46
hal mengenai desain visual
aplikasi?

7 Seberapa nyaman tata letak 4,46
dan desain aplikasi bagi
pengguna?

8 Seberapa cepat aplikasi 4,53
memuat halaman atau fitur
yang akan digunakan?

9 Aplikasi mudah digunakan 4,37
tanpa perlu penjelasan
tambahan

10 Layout halaman dirancang | 4,31
agar nyaman digunakan
dalam jangka panjang
11 Aplikasi tetap stabil tanpa 4,50
error atau crash selama
pemberian stimulus

12 Evaluasi secara menyeluruh | 4,62
menunjukkan bahwa baik
dari sisi desain maupun
operasional, aplikasi ini
telah dirancang dengan
baik untuk memenuhi
kebutuhan pengguna

Setuju

Setuju

Setuju

Setuju

Setuju

Setuju

Setuju

Setuju

B. Pengujian Data EEG

Bandpass Filter Ly Konversi CSV
(BPF) ke EDF

Dataset awal [—>|

o

Artifact
removal ICA

Segmentasi |« | Konversi EDF

Konversi EDF
ke CSV ke CSV

GAMBAR 33
(Diagram Proses Tahapan Pengujian)
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Dataset yang kami peroleh dari hasil perekaman EEG
akan diimpor ke perangkat desktop untuk proses pengolahan
lebih lanjut. Tahap pertama yang harus dilakukan ada proses
penyaringan menggunakan Band-pass Filter (BPF) melalui
MATLAB karena hanya 4 channel yang akan kami olah yaitu
TP9, AF7, AF8, TP10.

TABEL 3
(Dataset Hasil Perekaman EEG)
TimeStamp | RAW_TP9 | RAW_AF7 | RAW_AF8 | RAW_TPI0
00:01:24.9 | 23.4311 -5.89678 721773 9.297698
00:01:249 | 636.5617 649.1396 663.4152 620.1349
00:01:25.0 | 934.4297 929.5048 942.9647 880.3667
00:01:25.0 | 936.1657 877.8042 888.304 860.4584

Tabel diatas menampilkan contoh dataset responden yang
telah melalui proses filtering dan konversi dari CSV ke EDF
sebagai persiapan analisis ICA. Proses ICA digunakan untuk
mendekomposisi  sinyal EEG menjadi komponen
independen, serta mengidentifikasi artefak seperti gerakan
mata, aktivitas otot rahang, dan line noise yang dapat
proses klasifikasi sinyal.

Brain : 92.7'% Brain : B8.2% Brain : 77.0%
4 |
Line Noise : 64.0%
A
GAMBAR 34

Hasil Proses ICA
View components properties -...

Brain : 71.4%

‘, Brain : 88.6% Brain : 97.5%
GAMBAR 35
(Output ICA Setelah Remove Components from Data)

Setelah proses dekomposisi selesai, data bersih
(processed data) kemudian diubah kembali formatnya dari
EDF ke CSV untuk proses analisis selanjutnya. Data
kemudian akan diplot dan dianalisis menggunakan Fast
Fourier  Transform (FFT) yang bertujuan untuk
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mengklasifikasikan spektrum sinyal otak berdasarkan
karakteristik frekuensinya.

b AL 2555 b o

GAMBAR 36
(Magnitude Stimulus Audio)

GAMBAR 37
(Daya Stimulus Audio)

C. Hasil Pengujian

Eksperimen stimulus enhanced alfa menggunakan audio
Binaural Beats (BB) bertujuan meningkatkan osilasi sinyal
alfa (10 Hz) untuk menciptakan relaksasi. Efektivitas BB
dinilai dari penurunan stres, yang dilihat melalui perubahan
frekuensi dan daya sinyal beta (terutama beta tinggi 22-30
Hz yang berkaitan dengan kecemasan). Analisis
membandingkan osilasi sinyal alfa dan beta selama stimulus
video dan dua sesi audio, dari 5 responden namun hanya 3
data yang dapat digunakan. Hasil perbandingan ditampilkan
pada Tabel 4 (alfa) dan Tabel 5 (beta).

TABEL 4
(Analisis Frekuensi Alfa)

Respo Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RV1 9,75 13,04 19,5 15,49 29,5 12,69
RV4 9,75 12,12 19,5 12,32 29,5 12,49
RV3 8,00 11,96 19,5 3,16 19,5 0,38

Tabel menunjukkan frekuensi alfa stabil di tiap
responden, namun dayanya bervariasi. RV1 mengalami
lonjakan daya tertinggi saat Audio SI, sedangkan RVS justru
menurun drastis. Ini menunjukkan respons individu berbeda-
beda terhadap stimulus; RV1 paling sensitif, RV4 moderat,
dan RVS5 paling rendah. Temuan ini menegaskan bahwa
modulasi otak harus disesuaikan secara personal.

TABEL 5
(Analisis Frekuensi Beta)
Respo Video Audio SI Audio SII
nden
Frek. Daya Frek. Daya Frek. Daya
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RV1 21,25 12,58 19,5 15,49 29,5 12,69
RV4 19,5 12,04 19,5 12,82 29,5 12,49
RV5 13,5 7,31 19,5 3,16 19,5 0,38

Tabel 5 menunjukkan frekuensi beta cenderung stabil
pada RV1 dan RV4, namun melonjak ke 29,5 Hz pada Audio
SII, mencerminkan respons kognitif tinggi. RVS5
menunjukkan frekuensi rendah dan daya menurun drastis,
terutama pada Audio SII. Daya beta tertinggi tercatat pada
RVI1 saat Audio SI (15,49 pV?#Hz), sedangkan RVS5
mengalami penurunan ekstrem, kemungkinan karena
kelelahan atau gangguan fokus. Perbedaan ini menekankan
pentingnya pendekatan individual dalam pengaturan stimulus
kognitif.

GAMBAR 38
(Visualisasi Perbandingan Frekuensi dan Daya)

Analisis kedua dilakukan untuk data rekaman
menggunakan stimulus game-audio. Data yang dapat
digunakan hanya dari 3 dari 5 responden. Responden diminta
memainkan stimulus game, kemudian dilanjutkan dengan
stimulus audio sebanyak dua sesi.

TABEL 6
(Analisis Frekuensi Alfa)

Respo Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RGl 10,50 22,40 10,5 30,60 10,75 22,97
RG4 9,75 16,26 8,00 17,72 10,75 23,68
RG5 8 2,52 8,00 18,14 9 24,53

Tabel 6 menunjukkan bahwa RG2 konsisten memiliki
daya alfa tertinggi di semua stimulus dengan frekuensi stabil.
RG3 mengalami peningkatan daya meski frekuensinya
berfluktuasi, sementara RG4 menunjukkan lonjakan
signifikan dari daya rendah saat Game ke tinggi pada Audio
SII. Perbedaan ini mencerminkan sensitivitas individu
terhadap jenis stimulus, menekankan pentingnya intervensi
neuromodulasi yang dipersonalisasi.

TABEL 7
(Analsis Frekuensi Beta)

Respo Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RVI 21,25 12,58 19,5 15,49 29,5 12,69
RV4 19,5 12,04 19,5 12,82 29,5 12,49
RV5 13,5 7,31 19,5 3,16 19,5 0,38

Tabel 7 menunjukkan bahwa stimulus audio, khususnya
Audio SII, secara umum memicu peningkatan frekuensi dan
daya gelombang beta dibandingkan game. RG2
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mempertahankan frekuensi stabil, namun daya tertinggi
muncul saat Audio SI. RG3 dan RG4 menunjukkan
peningkatan frekuensi dan daya signifikan, menandakan
respons kognitif kuat terhadap audio. Hasil ini menegaskan
bahwa efektivitas stimulus audio bersifat individual.

» =
w =
== E
Pt i
1 20

GAMBAR 39
(Visualisasi Perbandingan Frekuensi dan Daya)

V. KESIMPULAN

Aplikasi Neurobliss terbukti stabil dan mudah digunakan
sebagai platform stimulasi sinyal alfa. Pengujian oleh 32
responden menghasilkan skor kepuasan rata-rata 4,47/5
untuk antarmuka, performa, dan keamanan data. Fitur
pemutaran audio binaural beats dan musik relaksasi berjalan
lancar tanpa error, sehingga aplikasi siap dipakai sebagai alat
bantu non-medis dalam pengelolaan kecemasan.

Analisis sinyal EEG mengonfirmasi bahwa Audio SI
menimbulkan lonjakan daya gelombang alfa hingga 15-40 %
pada sebagian besar peserta, meskipun frekuensi dominan
tetap stabil di 8-10 Hz. Audio SII dan stimulus game—audio
secara konsisten meningkatkan frekuensi dan daya
gelombang beta—tanda peningkatan kewaspadaan kognitif
atau potensi stres. Variasi respons individu, termasuk
beberapa penurunan daya alfa, menegaskan pentingnya
personalisasi protokol stimulasi.

Secara keseluruhan, Neurobliss berhasil memenuhi tujuan
penelitian dengan memfasilitasi observasi perubahan alfa dan
beta melalui antarmuka praktis. Aplikasi ini tidak hanya
mendemonstrasikan efektivitas stimulasi enhanced alpha
dalam mereduksi kecemasan, tetapi juga menyediakan
mekanisme monitoring beban mental berbasis EEG. Temuan
ini mendukung implementasi teknologi neuromodulasi yang
dapat disesuaikan untuk intervensi kesehatan mental di
kalangan mahasiswa.
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